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County VOTING TABULATION SYSTEM intercivic

eSlate Comprehensive Training Program

The following eSlate Master Course Design flowcharts show the relationships between the
courses offered in support of the eSlate System. Information for each course includes:

Course name

Recommended staff to receive the training

Training materials resource

Course objectives

Overview and detailed description of the course content

The eSlate Course Syllabi give greater detail to the courses shown in the Master Course Design.
Each course syllabus includes:

Course length

Recommended audience

Course objectives

Benefits of the eSlate System

Manuals available to support the course
Description of course modules

Course prerequisites

Detailed teaching points.

The eSlate System Training Planner presents the plan for training Boulder County Staff and Poll
Workers. This plan will be finalized upon review by and discussion with Boulder County.

© 2003 HART INTERCIVIC
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eSlate Master Course Design
Goal: Successful Operation

of the eSlate™

Electronic Voting System (EVS)

Course

Objective Synopsis:

Elections officials and

BOSS™ Operator
Training Course

administrators will
receive an eSlate
system management
overview and a
summary of all related
procedures and
documents, along with
specific steps for
performing both
eSlate management
functions and change
management
processes.

v

eSlate System
Management & Tasks
Course
5 Modules
1)Getting Started
2)eSlate Election-Related
Management
3)Planning eSlate Training
4) BOSS Admin. Tasks ,
Ballot Now Admin. Tasks ,
Tally Admin Tasks
Servo Admin Tasks
5) Appendices

Proprietary and Confidential
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Poll Worker's
eSlate
Operations
Course

v

Hart InterCivic eSlate

Training Specialists
(Resource: Handbook)

Objective
Synopsis:
Elections officials,
office staff, and
BOSS data entry
specialists will run
BOSS ballot
generating software
to define and create
eSlate PVS & Ballot
Now ballot formats
and MBBs.

A

Objective
Synopsis: Poll
workers will receive
training in the
specifics of operating
the eSlate and DAU
units. Trainees will
also learn how to
assist voters using
the eSlate and DAU
eSlate units.
Trainees will review
voter instructions
materials. Included
in Train-the-Trainer.

A 4

Polling Place
Operations
Course

v

BOSS Operator
Training Course
6 Modules
1)Getting Started
2) Jurisdiction &
Polling Places
3) Active Contest
Menu
4) Ballot Reports
5)Ballot Formats,
Audio, & PC cards
6)Administration
Tasks

Poll Worker's
eSlate
Operations
Course
2 Modules
1)eSlate Features
2)DAU eSlate
Features
3) Voter
Instructions

Objective Synopsis:
Elections officials, office
staff, and lead poll
workers and alternate

leads will receive training

in the specifics of
operating the eSlate and
DAU units, including
setting up the eSlate
system for the polling
place, opening the polls,
running the system,
assisting voters, closing
(or suspending) polls,
powering off the eSlate
system, handling
sensitive MBBs
appropriately, and
packing the eSlate
system. Included in
Train-the-Trainer.

Ballot Now™
Operator
Training

Course
(Optional By-
Mail/Absentee
Subsystem)

v

\4

eSlate Support
Procedures Course

v

Tally™ Operator
Training Course

Objective Synopsis:
Elections Officials,
office staff, and Ballot
Now operators will use
BOSS MBBs to create
paper scanable ballots.
Post election, said
users will scan ballots,
save Cast Vote
Records (CVRs) back
to MBBs, and send to
Tally for tabulation.

Objective
Synopsis:
Elections Officials,
office staff, &
tabulation
specialists will use
Tally software with
data from election
MBBs to tabulate an
election and create
election results

reports.

Objective Synopsis:
Elections Officials,
support personnel, and
warehouse staff will
review storage,
delivery, and
maintenance
recommendations,
physically set up eSlate
hardware (JBC, DAU,
and eSlate), connect it,
perform acceptance and
functionality testing,
perform logic and
accuracy testing prior to
an election, practice
troubleshooting
procedures, review MBB
processing procedures,
and perform backup
steps using Servo and
RestPVS.

v

y

Polling Place
Operations Course
6 Modules
1) Voter Instructions
2) Setting Up
3) Opening Polls
4) Working with Voters
from the JBC
5) Closing Polls
6) Simulation/Review

Ballot Now Operator
Training Course
8 Modules
1) Getting Started
2) Printing Ballots
3) Pre-Scanning Setup
4) Scanning Voted Ballots
5) Reviewing & Recording
Scanned Ballots
6) Reports
7) Closing an Election
8) Administration Tasks

Tally Operator
Training Course
6 Modules
1) Getting Started
2) Pre-Election
Activities
3) Election Day
Activities
4) Manual Votes,
Importing Votes from
Other Systems &
Closing Election
5) Reports
6) Administration Tasks

eSlate Support
Procedures Course
7 Modules
1) Storage, Delivery, &
Maintenance
2) Acceptance &
Functionality Testing
3) L&A Test
4) Pre and Post Election
Procedures
5) Troubleshooting
6) MBB Processing
Procedures
7)Post-Election Backup
Procedures
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Course
-eSlate EVS overview & course objectives Tasks Administration Tasks Administration Tasks
-eSlate EVS Data Flowchart BOSS Ballot Now (Optional By-Mail/ Servo
-eSlate EVS Terminology (from BOSS Course, Module 6, Absentee Subsystem) (from Support Procedures)
-eSlate Product Description Administration Tasks) (from Ballot Now Course, Module 8: -User Privileges
-Change Management -User Privileges Administration Tasks) _p|-Password Security
_Election Related Tasks: -User Privileges -Changing User Password
-Maintaining parties -Logging in to Ballot Now -Creating New User
-Importing polling places & -Logging out of the Current Election -Backup Procedures
precincts -Adding a User -Viewing Reports
Module 2; eSlate Election-Related -Import State Contests* -Deleting a User -Viewing the Audit Trail
Management -Creating a File to Import~ -Scan Batch Management Window
-eSlate EVS Workflow g -Setting secondary language -Viewing the Audit Trail
-Election-Related Tasks Checklist -Non-Election Related Tasks
-Password Tips i v
-Changing Passwords N .
- i Module 4 (cont.); eSlate
_\lifeev\rlsATIZ'i?tfg?lnce Administration Tasks -eSlate Equipment List
-Locking the database for Tally Tally -Creating Files for Import into BOSS
-CD backup before locking (from 'I'ally pourse, Module 6: —MBB.LabeIs
: Administration Tasks) -Election Logs
-eSlate Course Descriptions -User Privileges -JBC Reports
-Poll worker Training Recommendations % : : -Password Security -Backing Up An Election to CD ROM
-eSlate Master Course Design Agg?:;dt:selzitévaesi‘C:(S)ntests Window -Changing User Password -Ballot Creation Worksheet
-Example Training Planner -Creating New User -Outline of Training Mock Election
-Copying the BOSS database”

-Viewing the Audit Trail
-Recount Procedures
-Archiving the Election

ATaught in Tally Course, module 1

Trainer Materials: _' ?rainee Materials: 1

I—eSIate Training Specialist's Handbook I-AII software Operations Manuals

-All software Operations Manuals | |-AII system Training Manual s and

-All system Training Manuals and Desk References Desk References imeframe fo

Audience

-computer(s) with all software | -eSlate Product Description et Training: 3 hours

Deflmltlon: (All timeframes subject to,
|-Printers - eSlate System Management & Elections customization.)
-paper I Tasks Training Manual Officials and

Administratorg

|-Test and Election MBBs from BOSS -writing instruments for notetaking

I

I

-scanner for Ballot Now IDocument I

| |

I

-laser pointer | |

I—LCD projector

-projector screen M- |
-training evaluation forms for trainees, 1 per |
I

-self assessment for trainees, 1 per

Proprietary and Confidential
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BOSS Operator HART

Training Course Interctrlc
Module 2 x
Module 1 Jurisdiction Definition Module 3 i
Getting Started -Jurisdiction Form Active Contests
-eSlate EVS overview & course -County/State (Admin/Party Maintenance first) M 1 * %k
objectives -Ballot Instructions -Contest Types Administration Tasks
-eSlate EVS data flowchart -Precinct Form -Editing Ballot Instr./Text -User Privileges
-BOSS window -Add Precinct -Editing Active Contest -Election Related Tasks:
-BOSS menus -Split Precinct -Defining Dependent Contests -Party Maintenance
-Opening BOSS -Consolidate Precincts -Deactivate/Activate Contest -Setting secondary language
-Creating a BOSS database -Move/Delete Precinct -Re-sequence Contests -Recording Audio
-Opening/Deleting BOSS database -Rotation Form -Forcing Contest Positions -Importing polling places &
Election Definition -No Rotation -Add Candidate precincts
-Election Type -Equal Time Rotation -Add/Delete Candidates/Choices -Import State Contests*
-Election Date -Rotation By Precinct -Add/Delete Delegates -Creating a File to Import~
-Election Title -Contests Form -Import State Contests is -Non-Election Related Tasks
-Add Contests covered in Administration “Password Tips
-Ballot Text -Changing Passwords
-Delete Contests/Text -Users Maintenance
-Polling Places Form A 2 -View Audit Trail
-Add Polling Place -Locking the database for Tally
Rules F -Delete Polling Place Ballot Reports -CD backup before locking
P ules 'o:rn; Polli Pl - viewing/printing reports for
recincts for Polling Flaces proofreading and/or recordkeeping
- Assigning precincts to *Under the Active Contests Window
polling places for Early Voting AIn Appendix
and Election Day # **Taught in eSlate System
Administration Menu Tasks Module 5 Management & Tasks

-Party Maintenance

-Second Language for Ballot Formats

-Recording Audio

Contests
-Searching Audio

?rg;gr_Mg_ggITals:_ ______ | -Export/Import Audio

-eSlate Training Specialist's Handbook (optional)
-BOSS operations manual -Creating Administrative level
I—BOSS Training manual databases

-Copying Forward
-generating ballot formats for
eSlate and Ballot Now

-write to MBB/DAU

I

-laser pointer I

|-computer loaded with BOSS |

-LCD projector

| projector screen I

one computer per 1-2 trainees

I-

-1 MBB per JBC |
I
I
I
I

|-1 MBBfor Ballot Now
|-1 audio card per DAU

MBB's for recount, recover, and backup
-MBB ID labels

-CDR for BOSS database backup

-training evaluation forms for trainees, 1 per
| -self assessment for trainees, 1 per
-tralnee course completion certificates

Timeframe
for Training: 2 days
(All timeframes subject to
customization.)

Audience Definition:
elections officials, database
entry specialists

Mmoo T = — —
Trainee Materials:
-BOSS operations manual one per I
-BOSS Training Manual one per
-writing instrument for notetaking

Proprietary and Confidential
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Poll Worker's eSlate Operations

Course
eSlate Features DAU eSlate Features
How to Vote
-Pick up ACCESS CODE after qualifying Disabled Access
-Go to any open booth -DAU eSlate
-Select language (if second language option available) -headphones
-Enter ACCESS CODE -jelly switches (Tactile Input Switches)
-Make choices using the SELECT wheel and ENTER . -orientation to buttons
You can skip pages with the NEXT button. -sip and puff device
-Read the Ballot Summary Curbside Voting
-Press CAST BALLOT from last page of Ballot Summary -Getting the ACCESS CODE
Other Features -Checking for battery power
-PREV and NEXT -Entering the ACCESS CODE
-HELP -Disconnecting the eSlate (and DAU peripherals)
-write-in -Vote and Cast Ballot
-straight party -Re-connect and confirm Cast Ballot (and re-connect DAU peripherals)
-intentionally skipping contests
-canceling a choice
-changing a choice
-changing a choice from the Ballot Summary
-skipping the final contest
-multi-page Ballot Summary Module 3
Voter Instructions

Using the Script

-four-step voter instructions

e — o = — — —— — —— — — Casting the Ballot

Trainer Materials: | -the voter has finished voting when s/he sees the waving American flag

-eSlate Training Specialist's Handbook

I-Course agenda |

-eSlate Operations Desk Reference , 1 per poll |

worker

-Voters Instructions scripts |

|—Voter Instructions flyer s

I-"How to Vote" .mpg presentation |
I
I
I
I
I

-PowerPoint "poll worker" presentation Timeframe

|-LCD projector for Training:
-projectorscreen | |Trainee Materiale - = - 1 Audience 1 hour

I-eSIat'e PVS equipmen@ I_ Poll Worker's eSlate Operations Desk Reference, I Definition: (All timeframes subject to customization.)
—ele_ct_lon MBB an_d audio cards from BOSS -Voter Instructions script, all poll worker: Train-the-Trainer:
-training evaluation forms (optional) |-Voter Instructions flyer | (w/ Polling Place Operations)
-trainee written review, 1 per trainee (optional) -writing instruments for notetaking 2 days

I—trainee course completion certificates (optional) | |

_____________ -— — —— — —— — —— — — — — — — — o—

Proprietary and Confidential
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Module 1
Getting Started
-Hands on with the eSlate-eSlate EVS overview & course
objectives
-Common eSlate PVS terminology
-Review Voter Instruction Materials
-Flyers, Placards, Video or PowerPoint
Voter Instructions (Basic)
-Pick up ACCESS CODE from election judge after signing
in
-Go to any open booth
-Select language (if second language option available)
-Enter ACCESS CODE
-Make choices using the SELECT wheel and ENTER
-Read the Ballot Summary
-Press CAST BALLOT from the last page of Ballot
Summary
Other Features
-PREV and NEXT
-HELP
-write-in
-straight party
-intentionally skipping contests
-canceling a choice
-changing a choice
-changing a choice from the Ballot Summary
-skipping the final contest
-multi-page Ballot Summary

Polling Place

HART

fntercivic

-eSlate Training Specialist's Handbook |
|-eSIate Polling Place System Desk & Quick References |
I—Voter Instruction scripts, placards and flyers

-"How to Vote" .mpg presentation |
|—PowerPoint "Polling Place Operations" presentation |

-laser pointer
I—LCD projector |

-projector screen

-eSlate PVS equipment |

-election MBBs and audio cards from BOSS I
I-envelopes and stickers for MBB and DAU pc card

-envelopes for JBC reports |
|-JBC reconciliation and canceled booth logs/ 1 per JBC

-Mock voter qualification document I
I-training evaluation forms I
I—trainee written review, 1 per trainee

-trainee course completion certificates |

-Train-the-Trainer course trainer certification |

Proprietary and Confidential
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Operations
Course
Module 2
Setting Up

-Step 1:Check supplies

-Step 2:Plan Polling Place layout

-Step 3:Setting up the JBC(s)

-Step 4:Set up booths, eSlates & DAUs
-Make connections

-Check MBB/DAU cards

-Set up for curbside voting
-Identify/Implement security measures

Module 5
Closing the polls
-Suspending polls after Early Voting
-Polls Suspended report
-Re-opening the polls for Early Voting
-Confirming Public Count
-Closing polls at the end of Election Day
-Electronic Transfer of results data (modem
results)
-JBC Tally report
-Disconnecting Equipment

-Pack system

l

Module 3
Opening Polls
-Connect batteries and AC power
- JBC self-diagnostic
-eSlate Button functionality test
-Polling Place ID
-Early Voting/Election Day
-Assign booth numbers
-Print Zero Tape Report

-Compare Zero Tape Report to sample ballot for

ballot style verification (Election Day only)
-Open polls i

Module 6
Simulation/Review
-Perform simulation exercise
-Written Review
-Desk Reference Review
-Troubleshooting
-Security
-Guide to Serving Voters with Disabilities
-FAQ's
-Glossary

Module 4
Working with Voters from the JBC
-Adding Voters
-How to tell when a voter needs help
-Adding a provisional voter
-Checking/Printing ACCESS CODEs
-Canceling a booth
-Working with voters with disabilities
-Curbside voting

Trainee Materials: -
-eSlate Polling Place System Desk I
Reference |
-writing instruments for notetaking 3

Audience
Definition:
Elections Officials,
elections office staff,
poll workers who will
be
operating
the JBC

Timeframe
for Training: 4 hours
Train-the-Trainer:
2 days

All timeframes subject to
ustomization




M le 1

-Getting Started

-eSlate EVS overview & course objectives

-Recommendations, Phyisical Layout, and

Organizing Ballots
-Election Law
-How Ballot Now reads ballots
-Recommended processes
-Sorting (Received, Sorted,
AutoResolve for Undervotes,
Scanned, Rejected from Scan, To
be Duplicated, Printed, For
Review)

-eSlate EVS Data Flowchart

-Ballot Now window

-Ballot Now menus & preferences

-User Privileges

-Logging in to Ballot Now

BALLOT NOW
Operator Training Course
(Optional By-Mail/Absentee
Subsystem)

HART

intercivice

v

Module 3
-Pre-Scanning Set up
-Defining certified write-
in names and aliases
-Preferences/Ballot

-Opening an Election

]

M le 2
- Printing Ballots
-Pre-Printing Set up
-Preferences/Ballot Printing Tab

Resolution Tab (allowing e
free-form write-ins)
-Preferences/ Scanner set
up Tab

Module 5

Recording Scanned Ballots
-Resolving Unresolved Ballots

-Resolving Overvotes & Undervotes
-Resolving Certified Write-ins
-Resolving Free-form Write-ins
-AutoResolving Ballots

-Scan Batch Management

-Deleting a scan batch

-Saving CVRs to an MBB

Module 6
-Ballot Now Reports
-Listing of Available Reports
-Election
-Scanned Ballots by Precinct
-Scanned Ballots by Batch
-Unresolved Ballots
-Printed Ballots by Precinct
-Certified Write-ins
-Ballot Now Audit Trail
-Viewing & Printing Reports
-Exporting a Report to File

I

Module 7
Closing an Election
-Closing an election
-Logging out of Ballot Now

-Stub Label Options
-Print Selection Types
-Previewing & Printing Ballots

— e —— —— —— — —— — — —— — — —

ITrainer Materials:

-eSlate Training Specialist's Handbook
|-Ba|lot Now Operations Manual

-Ballot Now Training Manual

I-Ballot Now Organizational Forms
I-computer with Ballot Now software
-scanner

|-paper

-election MBB from BOSS

I-Iaser pointer

I-LCD projector

-projector screen

|-training evaluation forms for trainees, 1 per
I-self assessment for trainees, 1 per
-trainee course completion certificates

Proprietary and Confidential
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M le 4
Scanning Voted Ballots
-Grouping ballots into batches
-Loading pages into the scanner
-Scanning Ballots

q’rainee Materials:

-Ballot Now Operations Manual
I-Ballot Now Training Manual
-writing instruments for notetaking

Audience
Definition:
elections
officials, office
personnel,
Ballot Now
operator

Timeframe
for Training: 1 day

(All timeframes subject to
customization.)

M 1 XX
Administration Tasks
-User Privileges
-Changing a password
-Adding a User
-Deleting a User
-(Scan Batch Management)
-Viewing the Audit Trail

**Taught in eSlate System
Management & Tasks




M le 1
Tally, Getting Started
-eSlate EVS overview & course
objectives
-eSlate EVS data flowchart
-Tally Window
-Tally Menus
—»-Review of locking the BOSS
database for Tally
-Opening Tally
-Checking disk space
-Copying a BOSS database to
create Tally database
-Opening Tally database

M le 2
Pre-Election Activities
- Editing write-in candidates
- Adding aliases
- Defining Tally options
-Options for Consolidating Split Precincts
-Options for rejecting provisional ballots
- MBB Types
-Test Mode tabulation
- Possible MBB Error Messages

TALLY Operator
Training
Course

Module 3
Election Day Activities:
-Review: Election db is copied
from BOSS, pre-election
—wactivities are complete
-Opening an election
-Reading MBBs
-Rejecting Provisional ballots
-Assigning unassigned write-ins

.

HART
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M le 4
Manual Votes, Importing Votes
From Other Systems, & Closing
the Election:
-Manual votes
-Importing Votes from Other Systems
-Closing the Election

ITrainer Materials: I
-eSlate Training Specialist's Handbook

|-Tally Operations Manual |
-Tally Training Manual

-MBBs with CVRs from the eSlate PVS and Ballot Now I
-computer with BOSS & Tally loaded |
-line printer

-laser printer |
I-Iaser pointer I
-LCD projector

-projector screen |
-training evaluation forms for trainees, 1 per

|-se|f assessment for trainees, 1 per |
|-trainee course completion certificates |

Proprietary and Confidential
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Trainee Materials: 1
|—Ta||y Operations Manual |
-Tally Training Manual

-writing instruments for notetaking |

Audience
Definition:
elections

officials, office

personnel,
tabulation
specialist

!

Module 5

Reports
-Viewing and Printing Reports

Module 6**
Administration Tasks
-User Privileges
-Password Security
-Changing User Password
-Creating New User
-Copying the BOSS database”
-Viewing the Audit Trail
-Recount Procedures
-Archiving the Election
-Appendices

ATaught in Tally Course, module 1
**Taught in Administration:
Management & Tasks

Timeframe
for Training: 1 day

All timeframes subject to,
customization.)



Module 1
Storage, Delivery & Maintenance
-Storage requirements (humidity, temperature, size...)

-Storage recommendations (Booth Caddy, pallets, organization)

eSlate Support Procedures

HART

intercivic

-Delivery requirements & recommendations (security, transportation, cou rse
polling place prep....)
-Maintenance requirements
-Setting up eSlate system PC's and troubleshooting (appendix)
v Module 3

Module 2
Acceptance & Functionality Testing
-Checking Supplies
-Acceptance Test Procedures
Functionality Test
-Inventory equipment
-Test JBC button functions
-Test eSlate button functions
-Test DAU button functions
-Test ballot functionality
-Test screen functionality
-Test battery functionality
-Reset & Servo
-Booths and Caddy
-Review: setting up the JBC
-Review: setting up eSlates and DAU eSlates
-Review: opening the polls
-Review: closing the polls
Reset the system
- connect eSlate PVS to PC
- Open and initiate PVSReset program
- Check that "Reset" took place

equipment list)

- Check eSlate booths and install eSlates in booths
- Add eSlates to the equipment list with Servo

- Store eSlate PVS system for use at polling place
- Test batteries with Battery Pack Tester

- Repeat with each PVS system

- Set the JBC clock with Servo (automatically adds JBCs to

—»

?rainer Materials: 1
I-eSIate Training Specialist's Handbook |
-Two computers with all utility software

-reset cables |
-One JBC per 1-12 eSlates |
-MBB PC cards with current ballot format in
TEST mode (3-5) |
-Ballot spreadsheet and/or paper ballots

-One set of jelly switches, headphones per I
| DAU unit tested |
-Polling Place Operations Desk Reference
-eSlate Support Procedures training binder |
|-surge protector |
-L & A documentation form

-PowerPoint presentation |
|—training evaluation forms for trainees, 1 per
-trainee course completion certificates I

Proprietary and Confidential
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Logic and Accuracy Test

Prerequisites:

-In BOSS, write all election and test MBBs for current
election (including DAUSs),reflecting all ballot styles

-Lock BOSS election for Tally

-Copy BOSS database into Tally

L & A Test:

-Create a spreadsheet detailing ballot styles and races
needed to reflect one vote per "candidate", one per straight
party (if available), and one blank ballot

L & A Test Steps:

-Print a Tally Software Summary Zero Report of all contests
-Insert Test Mode MBB & DAU for current election

-Power up JBC & start open polls sequence in Early Voting
mode

-Print JBC Zero Tape Report

-Compare JBC Zero Tape Report and Tally Zero Report
-"Vote" Test paper ballots or spreadsheet, one for each
candidate, including straight party, and hand tabulate
-"Vote" on MBBs with eSlate PVS set in Early Voting mode
(all ballot styles available at one polling location) matching
voted paper ballots or spreadsheet

-Suspend polls and collect JBC Suspend Report

-Print JBC Daily Detail Report

-Verify that the JBC Public Count = # of ballots cast
-Read MBBs into Tally

-Print Tally Summary report of all contests

-Compare JBC suspend polls summary report to Tally
Summary report of all contests and to the paper ballot hand
tabulation

-Reconcile variances

-Document L & A Test and seal all records and MBBs in an
envelope

Module 5
Troubleshooting Guide (PVS)
-Aborted ACCESS CODEs Report
-Battery Operations
-Close Polls button pushed too early
-Connecting eSlate battery packs
-Connecting JBC battery packs
-Curbside eSlate errors
-DAU/Audio card errors
-DAU/Audio card removal
-DAU headphones or tactile input switches
do not work
-eSlate or DAU does not work
-Extra ACCESS CODEs
-Hot eSlate or JBC screen
-JBC does not work
-JBC Early Voting Question answered
incorrectly
-MBB error
-MBB removal
-Password error
-Power fails
-Power status on JBC and eSlate
-Printer errors/Disabled Printer
-Printer Paper, Changing
-Reading the JBC reports
-Replacing a JBC or eSlate
-Restarting the JBC
-System Alert messages
-Voter enters the wrong language
-Voter gets the wrong ballot style
-Voter's precinct ID on the JBC
-Voter Registration Computer does not work
-Voter requests a receipt
-Other JBC screens that may appear
-JBC & eSlate Replacement Procedures
-Troubleshooting PC Setup

Trainee |
Materials:

- Support |
IProcedures |
Training
|binder |
-writing I
instruments
for notetaking |
- Logs

Y

Module 4
Pre and Post Election Procedures
Pre and Post Election Checklists
Pre-Defining the JBC Polling Place ID (Optional)

Module 6
MBB Processing Procedures
-Steps for preparing MBBs and Reconciling
-Reading JBC tapes
-Logs , Labels, and Forms

-Materials

-Predefinition Procedures

-Setting the Polling Place ID for each JBC
Reset Procedures

Timeframe
for Training: 2 days
(All timeframes subject to
customization.)

Audience Definition:
Elections Officials, Warehouse
Specialists

v

Module 7
Post Election Procedures
-Using Servo software
-Backing up JBCs and eSlates
-Printing/Exporting Reports
-Other Servo features: Recount and Recovery
-Battery Test Procedures
-Maintenance References, misc.




eSlate Course Syllabus
eSlate System Management & Tasks Course

eSLATE COURSE SYLLABI

The following are summaries of Hart InterCivic’s Training Course
Syllabi. Complete Course Outlines and training schedule are
provided as part of full implementation planning.

eSlate System Management & Tasks Course

Estimated Time: 3 hours

Audience: Elections Officials, Elections Specialists

Objectives: This course provides Elections Administrators with an overview of eSlate
Electronic Voting System management, and the benefits of using the eSlate system. The
course includes a brief section on the change management process, in order to help
administrators successfully manage eSlate implementation and the change from a
legacy system. This course also introduces BOSS, Ballot Now, and Tally administrative
functions and options. The BOSS section is intended to demonstrate how to import files
created for states, precincts and polling places as well as instruct trainees in how to
create and save their own files for importing. It is also intended to demonstrate how to
use the Administration menu to set the secondary language and manage parties. In the
Ballot Now and Tally sections administrators will change information security-specific to
the software.

Benefits of the eSlate System: The eSlate system is simple to manage. All software
includes audit trail reports. The software is easy to navigate, as are the Judge’s Booth
Controller and the eSlate.

Manuals: eSlate System Management & Tasks Training Manual, eSlate Product
Description document BOSS, Ballot Now, and Tally Operations Manuals, BOSS, Ballot
Now and Tally Training Manuals.

Modules: Administration Management module 1, BOSS module 6, Ballot Now module 8,
Tally module 6

Prerequisite: Hands-on demonstration with the eSlate. Trainees will use the system as
if they are “voters”, if time and equipment availability allow.

Teaching Points:
» Getting Started
» System Overview and Benefits to Trainees, and Course Objectives
» eSlate Data Flowchart
» eSlate Terminology
» Change Management
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eSlate Course Syllabus
eSlate System Management & Tasks Course

> eSlate Election- Related Management
» eSlate Workflow
» eSlate Election-Related Tasks Checklist
» Planning eSlate Training
» eSlate Course Descriptions
» Poll worker Training recommendations
» eSlate Master Course Design
» Example Training Planner
> eSlate Administration Tasks
» BOSS tasks
» Ballot Now tasks
» Tally Tasks
» Servo Tasks
» Appendices
eSlate Equipment List
Creating Files to import into BOSS
MBB labels
Election Logs
JBC Reports
Archiving an Election to CD ROM
Ballot Creation Worksheet
Outline of Training Mock Election
> Review
> Q&A

VVVVVVYVYY
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eSlate Course Syllabus
BOSS

BOSS Operator Training Course

Estimated Time: 2 days
Audience: Boss Data Entry Specialists, Elections Officials

Objectives: This course introduces the BOSS program and takes the trainee through
the steps for setting up the ballot.

Benefits of BOSS: The eSlate Ballot Origination Software System, BOSS, requires only
data entry and menu selections to “program” an election. No software programming is
required. Furthermore operators may use cut/copy and paste and importing shortcuts to
make the process even simpler. There is no need to rebuild databases once a generic
election database is saved. Databases can be copied forward and modified for future
elections.

Manuals: BOSS Operations Manual, BOSS Training Manual
Other Materials: Election Organization outline for reference
Modules: 1-6

Prerequisite: Hands-on demonstration with the eSlate. Trainees will use the system as
if they are “voters”, if time and equipment availability allow.

Teaching Points:
» Module 1: Getting Started
System Overview and Benefits to Trainees, and Course Objectives
eSlate data flowchart, BOSS window, BOSS menus
Opening BOSS
Creating & Opening a BOSS database
Deleting a BOSS database
Election Definition Menu Option:

odule 2: Jurisdiction Definition and Polling Places
Jurisdiction Form
Precincts Form
Rotation Form
Contests Form
Polling Places Form
Rules Form

Y
VVVVVVE VVVYVYVYY
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eSlate Course Syllabus
BOSS (cont.)

» Precincts for Polling places Menu Option
> Adding/Removing polling places to Election Day
> Adding/Removing polling places to Early Voting
> Assigning Precincts to Polling Places

» Party Maintenance (Administration Menu)

» Second Language for Contests (Administration Menu)

» Module 3: Active Contests (Set Party Maintenance First)
» Contest Types

> Module 3, continued:

» Module 4: Ballot Reports
» Viewing and Printing Reports (proofreading)
» Listing of Available Reports

> Module 5: Audio & Ballot Formats
» Recording Audio

> Module 6: BOSS Administration Tasks
» User Privileges
» Election Related Tasks
» Non-Election Related Tasks
» Locking the database for Tally

» Appendices/Review;
> Q&A
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eSlate Course Syllabus
Poll Worker’s eSlate Operations

Poll Worker’s eSlate Operations Course

Estimated Time: 1 hour
Audience: All poll workers

Objectives: Trainees will become familiar with voting on the eSlate in order to instruct
and assist voters.

Benefits of the eSlate: The eSlate is simple to operate. There are on-screen prompts
that guide the voter through the voting process. Voters learn the system quickly. There
is no way a voter can overvote, and voters are reminded of their undervotes. There are
no voter intent issues. Voters with disabilities have equal and private access to voting.

Manuals: eSlate Poll Worker's Desk Reference

Other Materials: Poll worker Training PowerPoint Slideshow, Voter Instructions flyers,
Voter Instructions placards, Flag placards, Voter Instructions script, How to Vote
video/.mpg.

Modules: 1-3
Prerequisite: None

Teaching Points:
> Module 1: eSlate Features
» System Overview, Benefits to Trainees, and Course Objectives
» How to Vote
» Other Features

» Module 2: DAU eSlate Features (Demonstration Only)
» Disabled Access Unit
» Curbside Voting

> Module 3: Voter Instructions
» Voter Instructions

> Review
» Security, Guide to Serving Voters with Disabilities, FAQ’s
> Q&A.
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eSlate Course Syllabus
eSlate Polling Place Operations

eSlate Polling Place Operations Course

Estimated Time: 4 hours

Audience: Polling Place Judge’s Booth Controller (JBC) Operators (usually lead poll
workers and alternate lead poll workers or the equivalent), Elections Officials,
BOSS/Tally/Ballot Now Operators (optional)

Objectives: After completing this course the trainee will successfully instruct voters, set
up the eSlate Electronic Voting System polling place components, run the Judge’s Booth
Controller, assist voters, suspend (and reopen) or close the polls, and pack up the
eSlate equipment.

Benefits of the eSlate: The eSlate and JBC are lightweight, simple to operate with on-
screen prompts and easy to monitor. With the JBC it is not a difficult task to get the
voter’s correct ballot style/precinct. Voters quickly learn the system. There is no way a
voter can overvote, and voters are reminded of their undervotes. There are no voter
intent issues. Voters with disabilities have equal and private access to voting.

Manuals: eSlate Polling Place Operations Desk Reference

Other Materials: eSlate System Desk Reference, Voter Instructions Flyers & Placards,
Flag Placards, Voter Instructions Script, Reconciliation Log, Mock voter qualification log,
Written Review, Training Evaluation form, How to Vote video/.mpg and PowerPoint
slideshow(s).

Modules: 1-6

Prerequisite: Hands-on demonstration with the eSlate. Trainees will use the system as
if they are “voters” after they enter the classroom (as time allows).
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eSlate Course Syllabus

eSlate Polling Place Operations (cont.)

Teaching Points:

>

Module 1: Voter Instructions

» Getting Started - System Overview and Benefits to Trainees, and Course
Objectives

» Voter Instruction Materials

» Basic Voter Instructions

» Other Features

Module 2: Setting Up

» Step 1: Checking Supplies

» Step 2: Planning the Polling Place Layout
» Step 3: Setting up the JBC

» Step 4: Setting up the eSlates and DAUs

Module 3: Opening the Polls
» Opening for Early Voting (day 1), or Election Day

Module 4: Working With Voters from the JBC
Adding Voters

How to tell when a Voter Needs Help
Adding a Provisional Voter

Checking an ACCESS CODE

Canceling a booth

Working with Voters with Disabilities
Curbside Voting

VVVVVYVYY

Module 5: Closing the Polls

» Suspending the Polls for Early Voting
» Re-opening the Polls for Early Voting
» Closing the Polls for Election Day

» Disconnecting equipment

Module 6: Simulation/Review
» Simulation

» Appendices:

» Review/Q&A
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eSlate Course Syllabus
Ballot Now

Ballot Now Operator Training Course

Estimated Time: 1 day
Audience: Ballot Now Specialists, Elections Officials

Objectives: By the end of this course the trainee will be creating paper ballots using
BOSS™-generated MBBs. The trainee will also run voted paper ballots through the
Ballot Now scanner, resolve unresolved ballots, save the scanned cast vote records
back to the original election MBB, and prepare the cast vote record for Tally vote-
tabulating software.

Benefits of Ballot Now: Ballot Now integrates fully with the eSlate in-person voting
system. Ballot Now uses PC technology that is simple to operate, and requires no
programming. Ballot Now allows for printing, scanning, and resolving ballots. Ballot
Now ballots include bar codes for precinct and serial number identification, obviating the
need to sort ballots prior to scanning and preventing the same ballot from being scanned
more than once. Ballots that need resolution are not out-stacked, but resolved on the PC
by reviewing ballot images. The original ballot is not altered in order to resolve it, and it
is always available in its original form.

Manuals: Ballot Now Operations Manual, Ballot Now Training Manual
Modules: 1-8
Teaching Points:

» Module 1: Getting Started

System Overview and Benefits to Trainees, and Course Objectives
Recommendations/Physical Layout/Organizing Ballots

eSlate data flowchart, Ballot Now Window, Ballot Now menus, Ballot Now
preferences/Program Options window tabs

User Privileges

Logging in to Ballot Now

Opening an Election

VVV VVvVYy
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eSlate Course Syllabus
Ballot Now Course (cont.)

» Module 2: Printing
» Pre-Printing Setup
» Print Selection Types
» Previewing & Printing Ballots
» Printing a Printed Ballots By Precinct Report

» 3: Pre-Scanning Setup
» Defining Certified Write-In names and aliases.
» Preferences/Scanner Setup Tab

» Module 4: Scanning Voted Ballots
» Grouping Ballots into Batches
» Loading Pages into the Scanner
» Scanning Ballots
» Printing a Batch Scan Report

» Module 5: Recording Scanned Ballots
Resolving Unresolved Ballots

Scan Batch Management

Deleting a Scan Batch

Saving CVRs to the MBB

Printing an Audit Trail Report

VVVYVYY

» Module 6: Reports
» Viewing and Printing Reports
» Listing of Available Reports
» Exporting a Report to a File
» Sample Report

» Module 7: Closing an Election
» Closing an Election
» Logging out of Ballot Now

» Module 8: Ballot Now Administration Tasks
Ballot Now User Privileges

Changing a password

Adding A User

Deleting a User

(Scan Batch Management)

Viewing the Ballot Now Audit Trail
Appendices

VVVVVYVYY

» Appendices/Review
» Appendices;
» Review
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eSlate Course Syllabus
Tally

Tally Operator Training Course

Estimated Time: 1 day
Audience: Tabulation specialists, Elections Officials

Objectives: Trainees will open Tally and copy a BOSS database, set up Tally before the
election starts, read MBBs, look at challenged ballots, assign write-ins, enter absentee
and manual votes, viewing and printing Tally reports, close an election and archiving the
Tally database.

Benefits of Tally: Tally tabulates the cast votes with “one click” simplicity. Certified
write-ins can be identified before tabulation takes place, making counting votes for those
positions automatic. Provisional ballots can be automatically included in the count, or
not, and can be backed out or added if challenged. Test mode tabulations are kept in
separate databases from election mode databases.

Manuals: Tally Operations Manual, Tally Training Manual
Modules: 1-6

Prerequisite: Hands-on demonstration with the eSlate. Trainees will use the system as
if they are “voters”, if time and equipment availability allow.

Teaching Points:

» Module 1: Tally, Getting Started

System Overview and Benefits to Trainees, and Course Objectives
eSlate data flowchart, Tally Window, Tally menus

Review Locking the BOSS database for Tally

Opening Tally

Checking disk space

Copying a BOSS database to Tally

Opening a Tally database

VVVVVYVYY
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eSlate Course Syllabus
Tally (cont.)

» Module 2: Pre-Election Activities

Editing Write-In Candidates

Adding aliases

Defining Tally Options

Mobile Ballot Box Types

Test Mode Tabulation (Pre-Election Logic & Accuracy Test)
Possible MBB Error Messages

VVVVYVYY

» Module 3: Election Day Activities
» Opening an Election (with a new Tally database, Pre-Election Activities
completed sans Test Tabulation) & reading Election MBBs.
» Assigning unassigned write-ins

» Module 4: Manual Votes, Importing Votes from Other Systems & Closing
the Election

Manual Votes

Importing Votes from Other Systems

Closing the Election

Rejecting or Accepting Challenged Provisional Ballots

Backing Up the Tally Database to a CD-R.

VVVVYY

» Module 5: Reports
» Reports

» Module 6: Tally Administration Tasks

User Privileges

Password Security

Changing User Password

Creating New User

Copying a BOSS database (covered in Tally Course, Module 1)
Procedures for a recount or contested election

Viewing the Audit Trail (soft and paper formats)

Archiving the Election

Appendices

VVVVVVYVYYVYY

» Appendices/Review
» Appendices
> Q&A
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eSlate Course Syllabus
eSlate Support Procedures

eSlate Support Procedures Course

Estimated Time: 2 days

Audience: Warehouse Contacts, Elections Officials, and Information Specialists, and
support personnel

Objectives: Trainees will practice proper storage, delivery, and maintenance practices
for longevity of the eSlate components. Trainees will learn how to perform an
Acceptance/Functionality Test with the eSlate PVS, and reset the system. Trainees will
learn how to conduct logic and accuracy tests on the eSlate system to document that the
system is processing ballots properly. Trainees will also learn how to troubleshoot the
eSlate PVS and how to perform post-election backup procedures using the Servo utility.
Early Voting and Election Day MBB processors will review procedures for processing
MBBs and reconciling variances between ACCESS CODEs Voted and Voters Qualified
at the polling places.

Benefits of eSlate Support Procedures: With knowledge of eSlate support procedures
in hand local personnel can run full election cycles independently. All of the procedures
involved are straightforward, and they lend themselves to local modifications.

Manuals: eSlate Support Procedures Training Manual
Modules: 1-7

Prerequisite: Hands-on demonstration with the eSlate. Trainees will use the system as
if they are “voters”, if time and equipment availability allow.

Teaching Points:
» Module 1: Storage, Delivery & Maintenance
» Storage requirements (humidity, temperature, ...)
» Storage recommendations (stacking, pallets, organization)
» Delivery requirements
» Maintenance requirements

» Module 2: Acceptance & Functionality Testing
Checking supplies

Acceptance Test Procedures

Open and initiate Servo program

Review: Setting up the JBC

Review: Setting up eSlates and DAU eSlates
Review: Opening the polls

Review: Closing the polls for Election Day
Review: Reset the system

VVVVVVYYVYY
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eSlate Course Syllabus

eSlate Support Procedures (cont.)

» Module 3: Logic & Accuracy Testing
» Prerequisites:
» Logic and Accuracy Test Steps

> Module 4: Pre and Post Election Procedures
» Pre and Post Election Checklists
» Pre-Defining the JBC Polling Place ID
» Reset Procedures

» Module 5: Troubleshooting Guide
Aborted ACCESS CODEs Report
Battery Operations

Close Polls button pushed too early
Connecting eSlate battery packs
Connecting JBC battery packs
Curbside eSlate errors

DAU/Audio card errors

DAU/Audio card removal

DAU headphones or tactile input switches do not work
eSlate or DAU does not work

Extra ACCESS CODES

Hot eSlate or JBC screen

JBC does not work

JBC Early Voting Question answered incorrectly
MBB error

MBB removal

Password error

Power fails

Power status on JBC and eSlate
Printer errors/Disabled Printer
Printer Paper, Changing

Reading the JBC reports

Restarting the JBC

System Alert messages

Voter enters the wrong language
Voter gets the wrong ballot style
Voter's precinct ID on the JBC

VR computer does not work

Voter requests a receipt

Other JBC screens that may appear
JBC & eSlate Replacement Procedures
Troubleshooting PC Set Up

VVVVVVVVVVVVVVVVVVYVVVVVVVVVVYVYYYY
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eSlate Course Syllabus

eSlate Support Procedures (cont.)

» Module 6: MBB Processing Procedures
» Steps for preparing MBBs for Tally and reconciling variances in the number of
ACCESS CODEs Voted and the number of Voters Qualified at the polling
places
» Reading JBC tapes
» Logs, Labels, and Forms for tracking MBBs, equipment serial numbers, and
seals

» Module 7: Post Election Backup

Using the Servo utility

Backing up JBCs and eSlates

Printing/Exporting Reports

Conducting Recounts per district, per polling place, per contest, per election
Other Servo Features: Recount and Recovery MBBs, Audit Trail...

VVVVYY

» Appendices/Review
» Appendices
> Q&A
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eSlate Course Syllabus
Train-the-Trainer-eSlate Polling Place Operations

Train-the-Trainer

eSlate Polling Place Operations Course

Estimated Time: 2 days, 16 hours

Audience: Client employees and/or delegates who will be conducting eSlate Polling
Place Operations Courses.

Objectives: After completing this course the trainee will successfully conduct eSlate
Polling Place Operations Courses to teach lead Poll workers how to operate the eSlate
and DAU eSlate, instruct voters, set up the eSlate Electronic Voting System polling place
components, run the Judge’s Booth Controller, assist voters, suspend (and reopen) or
close the polls, and pack up the eSlate equipment.

Benefits of the eSlate: The eSlate and Judge’s Booth Controller (JBC) are lightweight,
simple to operate with on-screen prompts and easy to monitor. With the JBC it is not a
difficult task to get the voter’s correct ballot style/precinct. Voters quickly learn the
system. There is no way a voter can overvote, and voters are reminded of their
undervotes. Voters with disabilities have an equal and private access to voting.

Manuals: eSlate Polling Place Operations Desk Reference, Poll Worker’s eSlate Desk
Reference (soft and hard copy)

Other Materials: eSlate System Quick Reference, Voter Instructions Flyers & Placards,
Flag Placards, Poll Worker’'s Script, Reconciliation Log, Mock voter qualification log,
Written Review, Training Evaluation form, Tough Screen not Touch Screen document,
How to Vote video/.mpg and PowerPoint slideshow(s) (soft and hard copy as
appropriate)

Sections: 1-4

Prerequisite: Hands-on demonstration with the eSlate. Trainees will use the system as
if they are “voters” after they enter the classroom. Participation in a Hart
InterCivic eSlate Training Specialist led eSlate Polling Place Operations
Course.
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eSlate Course Syllabus

Train-the-Trainer eSlate Polling Place Operations (cont.)

Teaching Points:

X> Section 1: Teaching eSlate Training Courses —Andragogy
PP Letting learners know why something is important to learn, showing learners

how to direct themselves through the information, relating to the learners’
experiences, motivating learners, reinforcing learning in order to increase
retention and transference.

PP Hands-on based.

PP Fast paced.

PP Multi-sensory and Multi-media
PP Guided by reference materials

X> Section 2: System Expertise — Knowledge
PP Course Content:

> Module 1: Voter Instructions

>

>
>
>

Getting Started - System Overview and Benefits to Trainees, and Course
Objectives

Voter Instruction Materials

Basic Voter Instructions

Other Features

» Module 2: Setting Up

>
>
>
>

Step 1: Checking Supplies
Step 2: Planning the Polling Place Layout
Step 3: Setting up the JBC
Step 4: Setting up the eSlates and DAUs

» Module 3: Opening the Polls

>

Opening for Early Voting (day 1), or Election Day

» Module 4: Working With Voters from the JBC

VVVVVYVYY

Adding Voters

How to tell when a Voter Needs Help
Adding a Provisional Voter

Checking an ACCESS CODE
Canceling a booth

Working with Voters with Disabilities
Curbside Voting
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eSlate Course Syllabus
Train-the-Trainer eSlate Polling Place Operations (cont.)

» Module 5: Closing the Polls
» Suspending the Polls for Early Voting
» Re-opening the Polls for Early Voting
» Closing the Polls for Election Day
» Disconnecting equipment

> Module 6: Simulation/Review
» Simulation
» Appendices:
» Review/Q&A

X> Section 2: System Expertise — Knowledge (cont.)

PP Troubleshooting
» Troubleshooting guide (detail)
Aborted ACCESS CODEs Report
Battery Operations
Close Polls button pushed too early
Connecting eSlate/JBC battery packs
Curbside eSlate errors
DAU/Audio card errors
DAU/Audio card removal
DAU headphones or tactile input switches do not work
eSlate or DAU does not work
Extra ACCESS CODEs
JBC Early Voting Question answered incorrectly
MBB error
MBB removal
Password error
Power fails
Power status on JBC and eSlate
Printer errors/Disabled Printer
Printer Paper, Changing
Reading the JBC reports
Restarting the JBC
System Alert messages
Voter enters the wrong language
Voter gets the wrong ballot style
Voter needs DAU features
Voter's precinct ID on the JBC
VR computer does not work
Voter requests a receipt

VVVVVVVVVVVVVVVVVVVVVVVVYVYVYY

X> Section 2: System Expertise — Knowledge (cont.)
PP System Security
PP System Hardware
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eSlate Course Syllabus
Train-the-Trainer eSlate Polling Place Operations (cont.)

X> Section 3: Presentation Skills and Materials
PP Review Materials available
PP Presentation Techniques:
PP Trainees present and critique

X> Section 4: Review
M Q&A
P Trainee Exam

PP Certification and Agreement Clause (certificates to be mailed later, after
results of exam are in)
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eSlate Training Planner for Boulder County
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Central Office 6 6 6 4 6 2 2 6 3
Support/Warehouse Personnel 18 2 2 2 6 3
Paper Ballot Resolution Team Members 2
Substation Rally Operators 6 6
Lead Poll Workers 3 250 250 10
Alternate Lead Poll Workers 3 250 250
Poll Workers/Clerks 18 1100
Class size 8 24 8 8 8 10 16 24 50 24 50 24 24 20
Time allowed for course 2 hours 4 hours 2 days 1 day 1.5 days 2 hours 2 days 1 day 1 hour 4 hours 1 hour 4 hours 4 hours 2 days
Sessions per day 4 2 0.5 1 0.66 4 0.5 1 6 2 6 2 2 0.5
Number of trainees 6 24 6 8 8 10 8 18 0 24 1600 500 53 16
Number of sessions 1 1 1 1 1 1 1 1 0 1 32 21 3 1
Number of calendar days 0.25 0.5 2 1 1.5 0.25 2 1 0 0.5 55 10.5 1.5 2
Number of classroom hours 2 4 16 8 12 2 16 8 0 4 44 84 12 16
Number of trainer person-hours 3 6 24 12 18 3 24 12 0 6 66 126 18 24
Total Number of Trainees 2281 # of Precincts 250 # of Early Voting Polling Places 3
Total Calendar Days of Training 28.5 # of Registered Voters (estimate) 200,000 # of Election Day Polling Places 250
Total Classroom Hours of Training 228 # of By-Mail Voters (last election) 26,550
Total Trainer Person-Hours 342
# of Management-Level Trainees’ 22
# of Software Trainees® 58
# of Poll Worker Trainees® 2201

This is the eSlate Training Planner.

The table is based on:

No more than two software course trainees per available PC

Hart InterCivic Trainers leading the first phase of Election Day and Early Voting poll worker training

Conducting eSlate Operations Courses for poll workers before conducting eSlate Polling Place Operations training, as applicable
Conducting full eSlate Polling Place Operations training with lead and alternate lead poll workers

Including Re-Scheduled, or "Emergency"”, classes for up to 10% of the poll workers assigned to Polling Place Operations courses. This is a risk-reduction step.
Implementing Hart InterCivic's Train-the-trainer program for future poll worker training

Central Office Staff of up to 8

Support Staff of up to 8

Miscellaneous temporary and part-time staff

Note: the Intra-office Training Mock Election is intended as an in-house practice applying the skills learned in training. It is not a public test of the system.
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